
H800 3D Printer 
Version 1.1 



Afinia H800 3D Printer User’s Manual 

 

2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Afinia H800 3D Printer User’s Manual 

 

3 

TABLE OF CONTENTS 

Safety Precautions .................................................................................................................. 5 

Protecting the Printer .............................................................................................................. 5 

Overview ................................................................................................................................... 6 
Unpacking the Afinia H800 3D Printer............................................................................................... 8 
The Print Head ................................................................................................................................... 9 
The Control Buttons .......................................................................................................................... 9 

Installing the Afinia H800 3D Printer .................................................................................... 10 
Driver and Software Installation ...................................................................................................... 10 
Installing the Printer ........................................................................................................................ 10 
Loading the Filament ....................................................................................................................... 11 

Getting Ready to Print ........................................................................................................... 12 
Starting the Afinia 3D Program ........................................................................................................ 12 
Initializing the Printer ...................................................................................................................... 12 
Preparing the Platform .................................................................................................................... 13 
Leveling the Print Platform .............................................................................................................. 14 
Platform Calibration ........................................................................................................................ 15 
Automatic Platform Calibration ....................................................................................................... 15 
Manual Platform Calibration ........................................................................................................... 16 
Calibrating the Nozzle Height .......................................................................................................... 17 
Other Maintenance Options ............................................................................................................ 18 

Printing with the H800 3D Printer ......................................................................................... 20 
Loading a 3D Model ......................................................................................................................... 20 
View Options ................................................................................................................................... 22 
Model transformations .................................................................................................................... 22 
Placing Models onto the Build Platform .......................................................................................... 24 
Print Setup Options ......................................................................................................................... 25 
Print Settings ................................................................................................................................... 25 
Part Settings .................................................................................................................................... 25 
Printing ............................................................................................................................................ 29 
Print Options ................................................................................................................................... 29 

Save as Project ...................................................................................................................... 31 

Model Removal ...................................................................................................................... 32 
Removing Support Material ............................................................................................................ 33 

Maintenance ........................................................................................................................... 34 
Changing the Filament..................................................................................................................... 34 
Cleaning the Nozzle ......................................................................................................................... 35 
Removing / Changing the Nozzle ..................................................................................................... 35 
Cleaning the Extruder Gear ............................................................................................................. 36 
Cleaning the Platform ...................................................................................................................... 37 
Lubrication of Extruder Rails ........................................................................................................... 37 
Changing the HEPA Filter ................................................................................................................. 37 
Spare parts ...................................................................................................................................... 37 
Vertical Calibration .......................................................................................................................... 37 

Tips & Tricks .......................................................................................................................... 39 

Status Indicator ...................................................................................................................... 41 

Changing Languages ............................................................................................................ 41 

Updating the Printer ROM ..................................................................................................... 42 

Troubleshooting ..................................................................................................................... 42 

Specifications ........................................................................................................................ 45 

Technical Support .................................................................................................................. 46 

Acronyms and Jargon ........................................................................................................... 46 
 



Afinia H800 3D Printer User’s Manual 

 

4 

Afinia 1-Year Limited Warranty 
Below is the one-year limited warranty included with this Afinia product. Afinia prides itself on its outstanding 

product line and its technical support. If for some reason, your product fails, Afinia, a division of Microboards 

Technology, LLC, stands behind its warranties and assures you the best service possible in a quick and timely 

manner. 

Afinia warrants to the original purchaser that this product is free from defects in material and workmanship. 

Afinia will for one year, at its option, repair or replace at no charge for parts and labor from the date you 

purchased the product from an authorized Afinia reseller. Nozzles and Cell/Perf Boards are warranted for 

ninety (90) days. 

• Warranty registration must be completed within 30 days of receipt of the product in order to validate the 

warranty. 

• Afinia, a division of Microboards Technology, LLC, reserves the right to determine the validity of all warranty 

claims. 

• Warranty is void if the product serial number has been altered or removed. 

• Warranty is void if the product has been misused or damaged or if evidence is present that the product was 

altered, modified, or serviced by unauthorized service people. 

The above stated warranty is exclusive and replaces all other warranties, express of implied, including those of 

merchantability and fitness for a particular purpose. Afinia, a division of Microboards Technology, LLC, will not 

be liable for any other damages or loss, including incidental or consequential damages and loss of profits or 

revenues from whatever cause, including breach of warranty or negligence. 

This product has been thoroughly tested and inspected at the factory prior to shipment. Nevertheless, inspect 

your product completely for any damage or loss of parts that may have occurred during shipment. Notify the 

delivering carrier promptly if damage claims are to be filed. 

Afinia reserves the right to modify or update its product without obligation to replace any equipment delivered 

prior to any such change. 

 

To register your warranty, please visit www.afinia.com/register 
 
 
FCC ID: 026-H800 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 

this device may not cause harmful interference, and (2) this device must accept any interference received, 

including interference that may cause undesired operation. 

 

Changes or modifications not expressly approved by the party responsible for compliance could void the 

user's authority to operate the equipment. 

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference in a residential installation. This equipment generates, uses, and can radiate radio 

frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 

interference to radio communications. However, there is no guarantee that interference will not occur in a 

particular installation. If this equipment does cause harmful interference to radio or television reception, which 

can be determined by turning the equipment off and on, the user is encouraged to try to correct the 

interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver  

is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 
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Safety Precautions 
Please read this section carefully before using the printer. 

• The printer can only be used with the power adapters supplied by this company, or the 

product may be damaged, with a risk of fire. 

• To avoid burning or model deformation, do not touch the model, nozzle, or the platform by 

hand or any other part of the body while the printer is working or immediately after it has 

finished printing. 

• Protective glasses should always be worn when removing support material, especially 

PLA. 

• There is a slight smell from ABS when it is being extruded. A well-ventilated room is 

recommended; however when printing, keep the printer away from any drafts as this can 

affect the warping of ABS prints.  

• When ABS is burnt it releases toxic fumes. Never set the nozzle temperature high enough 

to burn the material. 

The following classifications are used in this manual: 

 

CAUTION: Indicates a potentially hazardous situation which, if not avoided, may 

result in minor or moderate injury. 

 

WARNING: Indicates a potentially hazardous situation which, if not avoided, may 

result in serious injury. 

 

GLOVES: When performing certain maintenance procedures, the machine may 

be hot and gloves are required to avoid burns. 

 

SAFETY GLASSES: Wear safety glasses to avoid injury to your eyes. 

Protecting the Printer 
• The printer must not be exposed to water or rain, or damage may occur. 

• Do not shut down the Afinia H800 3D System or pull out the USB cable when loading a 

digital model or the model data may be lost. 

• When using the “Extrude” function, keep at least 50mm between the nozzle and the 

platform. If too close, the nozzle may get blocked. 

• The printer is designed to work properly at an ambient temperature of between 60°F and 

85°F and humidity of between 20% and 50%. Operating outside these limits may result in 

low quality models.  
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Overview 
The Afinia H800 was designed specifically for educators and professionals looking for fast, 

hassle-free 3D printing with exceptional quality. The Afinia H800 boasts a host of features, from 

Smart Support, user-friendly software and automatic leveling, to paper-thin layer HD resolution 

with a heated build platform.  Everything about this printer is geared towards creating high 

standard professional 3D models. 

Print a working bearing in one design, make a part for a dishwasher or just unleash your creativity 

and bring your designs to life with your new Afinia H800. 

 

The Afinia 3D software sends the print data from a Mac or PC to the Printer over a single USB 

cable. The Extruder delivers the Filament from the Spool into the Nozzle, which heats the filament 

to printing temperature and deposits it on the Platform.  

100 Micron 
High-Definition Detail 

Large 10” x 8” x 8” 
Build Platform 

HEPA Air 
Filtration System 

Fully Automated 
Calibration 

Easy Filament 
Replacement 

Smart Support 
Technology 

One-Button Filament 
Change-out 

51dB - Quiet 
and Fast! 
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The Afinia H800 with HEPA filter is packed with advanced technologies in a stylish and robust 

design.  
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Unpacking the Afinia H800 3D Printer 
The Afinia H800 3D Printer weighs over 40 pounds and should be team-lifted!  

Remove the power cord and 4 perf boards from the top foam piece. 

Remove top foam from the box. Lift the foam ring from around the printer. 

With two people, carefully lift the Printer from the box.  

Lift the foam sheet below the printer and remove the Accessory Pack, 

Power Supply, Putty Knife, and Snipping Pliers.  

Lift the top cover and carefully lift out the foam above the platform. 

 

Open the front door and carefully remove the two pieces of foam from 

under the platform. Tip each foam piece back until it is lying flat, then 

turn the foam counter-clockwise until the left end of the foam is through 

the door.   

 

 

 

Use the snipping pliers to carefully cut the 6 labeled 

retaining strap loops from around the Print Head rails 

near the top of the printer.   

Cut only the straps! 

 

 

Next, check the Accessories: 

• Reel of Filament (1, Natural/White) 

• Power Supply 

• Power Cable 

• USB Cable 

• FR-4 (Perf) Boards 

• Extra Nozzle 

• Nozzle Wrench 

• Hex Wrenches  

• Putty Knife 

• Snipping Pliers 
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The Print Head 
The Print Head is held in place using three guide magnets in the extruder bracket. 

 

The Print Head is already installed in the Printer. You do not need to do any assembly. 

The Control Buttons 
You can do a lot with your Afinia H800 by using the Control Buttons, so it follows your every 

command.  

You also use the Afinia software to control the Afinia H800. 

 

 

 

  
Filament Button 

Power Button Pause Button 
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Installing the Afinia H800 3D Printer 
You will need the USB Cable, Power Supply and Cable, and Filament Spool to complete the Afinia 

H800 3D Printer installation. 

 

Driver and Software Installation 

Mac 

Insert the Installation Disc into your Mac. Open the disc, go into the Mac folder, and 

double-click Afinia Mac Setup.pkg. Follow the prompts through the installation. The drivers 

will be added and the Afinia software will be installed to the Applications folder.  

Windows 

Insert the Installation Disc into your PC. If the installer does not launch automatically, start the 

Afinia 3D Printer setup.exe file in the PC directory on the installation disc.  

Note: This installs the Afinia 3D Printer software, the Afinia 3D Printer drivers, and the Afinia 

3D Printer sample files into your Program files\Afinia\Afinia 3D Printer folder. 

Follow the instructions in the Installer to be sure the drivers and software are all in place 

before attempting to use the Printer. The instructions below will follow the same order as those 

in the Installer. 

Installing the Printer 

 

Connect the power adapter as shown with the flat side out and turn 

on the power switch. 

 

Long Press the Power button on the control panel to initialize the 

printer. 

 

Connect the printer to your computer using the supplied USB cable. 

 

The Printer will be recognized and automatically installed when it is connected to 

your PC or Mac. 

 

  

USB connection 
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Loading the Filament 
 

 

A. Insert the end of filament into one end of the Filament tube, 

which is on the upper right side of the spool holder.  

 

 

B. Feed the filament through the tube until about 4 inches of 

filament protrudes from the tube. 

 

 

C. Put the Filament Spool onto the holder with the end of the filament pointing up from the 

back.  

 

 

D. Feed the filament into the extruder head as far as it can 

go, about 2 inches. 

 

E. Long Press the Filament button. 

a. If the filament doesn’t start feeding when the 

printer beeps, gently push in the filament. 

 

 

 

 

F. Replace the magnetic filament cover. 
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Getting Ready to Print 
Starting the Afinia 3D Program 
Open the Afinia 3D software on the desktop (Windows) or in the Applications folder (Mac). 

           Windows version        Mac version 

Initializing the Printer 
Long Press the Power Button or click Initialize in the 3D Print menu. The printer will beep, the 

platform and print head will move to the printer’s home positions, and beep again when it is ready.  

              Windows version         Mac version 

TIP: If your printer is not responding properly, always first try to re-initialize the printer. 
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Preparing the Platform 
The print platform needs to be prepared so the model adheres to the platform enough to be printed 

while still being easy to remove from the platform when done.  

Never print directly to the aluminum platform! 

There are several options: 

FR-4 Board (Glass-reinforced Epoxy Laminate) 

The FR-4 Board, also called the “Perf” board, is held 

in place by the 13 mounting screws and two 

spring-loaded bearings.  

Apply slight downward pressure on the two spring 

bearings when sliding the perf board back into place. 

The heads of all 13 mounting screws will lock down 

the board when installed correctly. 

 

Borofloat Glass 

Many people use Borofloat glass as the print surface, brushed with an ABS/acetone slurry and 

allowed to dry into a thin ABS film.  

The ABS film will hold the model to the glass, and release from the glass as the glass cools.  

If the model does not easily release, spray a small amount of ammonia-based glass cleaner 

around the model. The same glass cleaner can be used to clean the film from the glass. 

It is recommended that you clean and recoat the print surface after each print.  

The Borofloat glass can be placed directly on top of the installed perf board or on the platform 

screws.  Use office clips to hold the glass in place. 

BuildTak Print Surface 

BuildTak is a print surface that self-adheres to the Perf board or to glass. If adhering to glass, be 

sure that no air is trapped between the glass and the BuildTak.  

Position the BuildTak surface on the actual print zone – the Perf board is larger than the surface, 

with the perimeter outside of the print zone. 

Borofloat glass and BuildTak are available at store.afinia.com. 

 

Whichever platform preparation method you use, having a well-leveled platform, a 

correctly-set nozzle height, and a pre-heated print surface will improve your results. 

The next few pages walk you through these steps.   
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Leveling the Print Platform 

Before calibrating the nozzle height, check the vertical nozzle distance at each corner and center 

of the print platform. Open Maintenance from the 3D Print menu and click the Center button.  

 

 

If you know the nozzle height, enter that height in the To: box, then click the To: button.  

If you don’t know the nozzle height, click the To: button to bring the platform to the displayed 

height, then slowly increase the height until the platform is about 0.2 mm from the nozzle, clicking 

To: after each increase.  

Use the five position buttons to check that the platform at all four corners and the center are close 

to the same distance from the nozzle. 

If the platform is not close to the same distance from the nozzle at 

all five points, adjust the platform until it is as level as possible. 

Use the 3 Leveling Dials under the platform arm to level the print 

platform.  

Turning a dial clockwise will raise the platform above that dial. 

 

Always recalibrate the platform and nozzle height after leveling the 

platform. 

 

The more level your platform is, the better your print will be! 

  

Mac version Windows version 

Leveling Dials 

(Viewed from under platform) 
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Platform Calibration 
Along with manual leveling the platform, the Afinia software can run a Platform Calibration to 

adjust the printing of the raft, laying down a level foundation for your model to be printed on.  

This process is not intended to replace physically leveling the platform, but to work with the 

leveling. 

Note: The Platform Calibration will only affect printing when using a raft. If you are printing without 

a raft, the Calibration is not used. 

You can calibrate the platform automatically or manually. 

Automatic Platform Calibration 
The automatic process will check the height of nine calibration points on the platform.  

Select Auto Level from the 3D Print menu.  

The differences in height between the nine calibration points are used to build up the raft to give 

your model a level foundation on which to print.  

 

 

After the Calibration is complete, the 

Nozzle Height will be automatically set. 

 

 

 

 

 

 

To check the calibration values, open the Platform 

Calibrate option in the 3D Print menu. Calibration 

values are in the middle section of that window. 

 

 

NOTE: If the Platform Calibrate window doesn’t open 

(Mac) or any of the values are left empty (PC), 

the platform is out-of-level by more than 0.9mm 

at one or more points. You will need to 

manually level the platform before running the 

Platform Calibration again (see page 14). 
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Manual Platform Calibration 
Select Platform Calibrate from the 3D Print menu. 

Click the button labeled 5 to move the nozzle to the 

center of the platform. Use the Up button to raise the 

platform.  

Hold the button down to move the platform steadily, or 

use single clicks to fine-tune the platform height.  

If you are using clips to secure the print surface to the 

platform, be careful to position the clips so they do not 

interfere with the nozzle or wind barrier. 

Raise the platform until the print surface is just 

touching the nozzle and note the current height.  

Click the Down button a few times to lower the 

platform and check the other 8 calibration points.  

Once you have found the calibration point with the 

lowest nozzle height, move to that point and adjust 

the platform position so the nozzle is just touching the 

print surface.  

 

Click Set nozzle height. 

 

Once the nozzle height is set, select the distances 

from the drop-down lists that brings the platform at 

the other 8 points into contact with the nozzle.  

Once all 9 values have been entered, click Apply 

current values. 

Reset will clear all calibration values.    

Click Quit when you are finished. 

 

 

 

 

 

In the example above, the print surface is slightly warped with the center higher than both the front 

and back edges. The manual leveling process would not be able to account for the warp, but the 

Platform Calibration can. 
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Calibrating the Nozzle Height 
This section is one of the most important of the entire manual. Please read it 

carefully to help you understand the nozzle height setup procedure. 

To print successfully, the platform should be 0.2mm from the nozzle. As each printer is slightly 

different, this distance needs to be calibrated before starting to print.  

You can set the nozzle height either automatically or manually.  

If you are using any print surface other than the supplied FR-4 (Perf) Board, you will need to set 

the Nozzle Height manually! 

Automatic Nozzle Height Calibration 
The Automatic Nozzle Height Calibration process will only work with the supplied FR-4 perf board 

as the print surface. If you are using any other surface, or the perf board with BuildTak or any other 

surface adhered to the board, manually set the nozzle height. 

 

Select Nozzle Height Detect from the 3D Print menu.   

The extruder will move to the back left of the printer and the platform 

will lift until the nozzle contacts the Nozzle Sensor. The detected 

nozzle height will then be displayed.  

Click OK to close the window and your nozzle height is set! 

 

Manual Nozzle Height Calibration 
To manually set the correct nozzle height: 

1. Open Maintenance from the 3D Print menu. The current nozzle height is shown in the 

Maintenance dialog images below.  

In the Windows example, the platform is at the bottom of the printer; the Mac example has 

the platform 135.5mm from the bottom.  

 

2. Click the Center button. 

3. Raise the platform by entering a value into the To: textbox and click the To button.  

4. Check the distance between the nozzle and the print surface. If the platform is more than 

0.2mm from the nozzle, slowly raise the To value and click the To button each time. Small 

changes will help avoid striking the print surface into the nozzle.  

Mac version Windows version 



Afinia H800 3D Printer User’s Manual 

 

18 

5. Repeat until the print surface is 

0.2mm from the nozzle, about the 

thickness of a piece of paper 

folded in half.  

6. Check the nozzle height at all four 

corners of the platform. If any of 

the corners is closer to the nozzle 

than the center, use that point to 

set the height.  

7. With the print surface 0.2mm from 

the nozzle, click the Set Nozzle 

Height button to save the current nozzle height.  

If you haven’t manually re-leveled the platform since the last time the Auto Level 

was run, you can stop here.  If you have manually leveled the platform, follow the 

next 4 steps. 

8. Take note of the nozzle height - you may need to reset the height when you run the Auto 

Level feature again.  

9. Select Auto Level from the 3D Print menu. 

10. After the Auto Level finishes, the automatic Nozzle Height detection will be run again.  

11. Once that is complete, go back into the Maintenance window, set To to the value from 

step 7, and click the Set Nozzle Height button. 

TIP: If the print surface contacts the nozzle while making height adjustments, re-initialize the 

printer and before undertaking any other operations. 

Other Maintenance Options 
Extrude heats the nozzle and loads material into the nozzle. When the temperature is high 

enough the material is squeezed out of the nozzle. The printer beeps before material starts 

extruding and it beeps again when finished.  

Withdraw clears the filament from the nozzle when you change the filament or if the nozzle needs 

to be cleaned. When the nozzle is up to temperature and the printer beeps, gently pull out the 

material.  

New Spool is used by the software to keep track of how much material has been used on the 

spool, and will warn you if you don’t have enough material left to print your model.  

Click the button and enter the grams of material on the spool. If it is a new spool, enter the weight 

of the filament in grams. Also select the filament type to set the nozzle and platform temperatures. 

 

 

Mac version Windows version 
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TIP: An empty Afinia Premium spool weighs about 280 grams. If you are installing a partially used 

Afinia Premium filament spool, weigh it, and subtract 280 grams from the weight. Enter that value 

into the material Weight text box. 

Status 

This area displays the current temperature of the nozzle and platform and if either element is 

currently being heated. 

Nozzle & Platform Position Controls 

The five buttons (FL, FR, Center, NL, NR) control the position of the nozzle and the platform.  

The To button controls the height of the platform, and is used in the manual nozzle height 

calibration procedure described on page 17. 

Bottom returns the platform to the lowest position.  

Set Nozzle Height 

Uses the value in the To box and saves it as the Nozzle Height. 

Stop All 

Stops heating and all the movement of the printer. Once you click this button, the current model 

being printed is cancelled.  

You CANNOT resume a print job once the printer has been stopped.  

Pause Print 

This button will pause a print in mid-progress while allowing you to resume the print job where it 

left off. This is useful if you want to change the material color mid-print or to allow fasteners to be 

inserted into printed cavities and then printed over to lock the fastener into place. 

This option is only available when the printer is printing and above the first four printed layers. 

Table Heat 1 hr 

Click the Table Heat 1 hr button to heat the table for a full hour to the correct temperature for the 

selected filament type. 

The Status bar will show the 

progress of the platform heating. 

Heating the platform will not take the full hour, but the longer the platform heats, the more the outer 

edges of the platform will be heated. For prints extending close to the edge of the platform, this will 

help prevent warping of the model during printing. 

Note: You should always preheat the platform prior to printing to ensure the best results. 

Stop Preheat (Windows) / Stop Heat (Mac) 

This button halts any heating of the table, either the 1 hour heat or the 15 minute preheat from the 

3D Print menu or control panel.  

This option only appears when the table is being heated. 
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Printing with the H800 3D Printer 

Loading a 
3D Model 
Click File / Open or 

the Open icon on the 

toolbar (Windows 

only) and select the 

model you want to 

open. The Afinia 3D 

Printer software only 

supports STL files, 

UP3, and UPP 

formats. 

 

 

You can open several models and print them 

all at the same time; see Placing Models 

onto the Build Platform (page 24). 

Insert Copy   

Add multiple copies of the same model to the 

platform by selecting Insert Copy from the 

right-click options (Windows) or by selecting 

Copy from the Tools menu. Select the 

number of copies to add from the list.  

You will need to reposition the models after 

the copies have been added. 

 

Unloading the Model, Windows   

Left-click a model and then click 

Unload on the toolbar to remove 

the selected model. 

You can also right-click anywhere in 

the software window then choose 

Unload by the selected model 

name or Unload All models if you 

want to clear everything. 

Unloading the Model, Mac   

Use either the Unload or Unload 

All button in the right tool pane. 

Click the Unload button to remove the currently selected model, or Unload All to clear all models 

from the workspace.  

Mac Software Windows Software 

Multiple parts, 

Windows Software 

Unload with Right-click 

Windows Software 
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Note on STL files: For a model to print correctly, all the faces of the models need to have their 

normals facing outwards. The Afinia H800 3D Printer software uses model color to show problems 

- if any part of the model is red the normals are facing the wrong direction in that place. 

Fixing STL Files 

The Afinia 3D Printer software includes a Fix option that 

will try to fix any bad surfaces in your model. Under the 

Edit menu in Windows you will see Fix, and under the 

Tools menu in Mac will be the Autofix option. Select 

the model, and click Fix or Autofix to attempt a repair 

of the bad surfaces. 

 

Saving the model  

Choose the model and select Save from the File menu. The file is saved in UP3 format with the file 

size being 13%-18% of the original STL file size. This is a convenient format for users to archive or 

transfer files. 

 

Saving the model as a project  

Choose the model and select Save As Project from the File menu. All of the settings within the 

Setup or Preferences will be saved, as well as the Quality and No Raft settings. 

The settings that are not saved within a project include the Nozzle Height, UnSolid Model, Heat 

platform after finish, and Pause at settings. 

The project file is saved with an extension of UPP. This file can be copied to other locations or 

computers without needing to include the original STL file or files.  

 

Merging Models   

If you have loaded more than one part onto the 

platform, combine them into a “single” print by 

using Merge from the Edit menu in Windows 

or the Tools menu in Mac. 

Open all the models you want to merge, 

arrange them the way you want on the platform, 

and click the Merge option. If you save the file, 

all the components will be saved as a single UP3 

file. 

  

Multiple parts, 

Mac Software 

See page 40 for more information on 

Surface Normals and Model Manifold 

requirements! 
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View Options 
The mouse can be used to rotate, pan, or zoom the view of the models. 

Rotate  

Press the middle mouse button and move the mouse to rotate the view. 

Pan  

Press Ctrl and the middle mouse button at the same time and move the mouse to pan. You can 

also use the arrow keys to pan the view. 

Scale  

Rotate the mouse wheel. The view will zoom in or out. 

View  

The system has eight preset standard views, the 

default view being Fit. Click View on the toolbar 

(Windows) or the View menu to select the View 

options. 

The caption under the View button will show the 

selected view name. 

 

 

 

Model transformations 
Models can be moved, rotated, or scaled using the Edit menu or the toolbar:  

 

 

Moving the Model 

Click the Move button and choose or input into the text box the distance you 

want to move. Then choose the axis (direction) in which you want to move. 

Each time you click the axis button the model will move again. 

For example: To move the model -5mm along Z axis (or down 5mm):  

Windows version 

Mac version 

Mac version Windows version 



Afinia H800 3D Printer User’s Manual 

 

23 

Windows Mac 

 

1. Click Move 

2. Input -5 in the text box 

3. Click the Z axis button 

 

1. Select the Move option 

2. Input 5 in the text box 

3. Click the Z- button 

 

Windows TIP: If you hold down the Ctrl key, you can drag the model to a position. 

 

Rotating the Model   

Click the Rotate button on the toolbar, choose or input into the text box how 

many degrees you want to rotate, and then choose the axis of rotation. 

For example: To rotate the model around Y axis by 30°.  

Windows Mac 

 

1. Click Rotate 

2. Input 30 in the text box 

3. Click the Y axis button 

 

1. Select the Rotate option 

2. Input 30 in the text box 

3. Click the Y+ button. 

Positive numbers rotate the model counterclockwise; negative numbers rotate the model 

clockwise. 

Scaling the Model   

Click the Scale button on the toolbar, choose or input in the text box a scaling 

factor, and then scale the model uniformly by clicking Scale. If you only want 

to scale along one axis, click the axis around which you want the change to be 

applied.  

Example 1: Scale up the model uniformly by 2.0 times. 

Windows Mac 

 

1. Click Scale 

2. Input 2.0 in the text box 

3. Click the Scale button 

 

1. Select the Scale option 

2. Input 2.0 in the text box 

3. Click the Scale 

button 

Example 2: Scale up the model by 1.2 times along the Z axis only.  

Windows Mac 

 

1. Click Scale 

2. Input 1.2 in the text box 

3. Click the Z Axis button 

 

1. Select the Scale option 

2. Input 1.2 in the text box 

3. Click the Z+ button 

Example 3: Scaling to convert inches to mm. 
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Occasionally an stl file may appear much smaller or much larger than designed. This is due to the 

design software saving the units of measure as inches rather than millimeters; the Afinia 3D 

software uses millimeters only, so a 1 inch model would appear as 1 millimeter.  

This is simple to resolve with these steps: 

Windows Mac 

 

1. Click Scale 

2. Select or input 25.4 in 

the text box 

3. Click the Scale button 

 

1. Select the Scale option 

2. Input 25.4 in the text box 

3. Click the Scale 

button 

If the model initially appears much too large, convert the size from millimeters to inches by 

selecting (PC only) or entering 0.03937 into the text box and clicking the Scale button. 

This does not actually change the model’s measurements, just scales it in the software. 

Placing Models onto the Build Platform 
Where you put your models on the platform can affect print quality. 

TIP: In general, try to place your model in the center of the platform. 

Auto Place   

Click Auto Place, on the far right of the toolbar, to center the model on the platform or arrange 

multiple models.  

When there is more than one model on the platform, using Auto Place is recommended. 

Windows TIP: Check the Auto Place option in the File menu to automatically position the model 

on the platform when the model file is opened. 

By Hand (Windows)   

Press the Ctrl key and choose the target model by pressing and holding the left mouse button. 

Move the mouse and drag the model to the desired position. 

Using the Move button   

Click the Move button (Windows) or the Move parameter (Mac) on the toolbar, choose or input the 

distance in the text box, and then choose the axis for the direction in which you want to move. 

NOTE: When more than one model is open, the gap between each model should be kept to at 

least 12mm to prevent the models sticking together or rafts from overlapping. 
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Print Setup Options 
Click the Setup option in the 3D Print menu or the Preferences button on the Print and Print 

Preview windows.  

  

 

 

Print Settings 

Z Resolution   

This setting decides the layer thickness of the printer. Options are 0.10mm to 0.40mm thick layers. 

Part Settings 

Angle   

The Part Angle sets the horizontal printing orientation for fill printing. At 45 Deg, the part will be 

filled in with material printed at 45 degrees to the X- and Y-axes.  

The orientation of the part itself will not be changed; just the angle the fill material and solid layers 

are printed. 

Surface   

This setting determines how many layers form the bottom face of a part when it is not solid. If you 

set it to 5, the printer will print 5 complete layers before printing infill.  

You may see more layers printing solidly if you are using very thin layer thicknesses. This is 

normal. 

This does not affect the side wall thickness, which will be approximately 1.5mm regardless of the 

fill mode.   

Mac version 

Windows version 
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Fill Settings 

There are four ways to fill the interior of the parts, as described below.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Shell 

For no fill, select Shell. 

Checking the Shell setting will reduce the material use and print time by not printing the fill 

material. 

Some models may not be suited to printing with the Shell setting checked.    

This will not affect the printed model’s wall thickness or support material requirements. 

Surface 

The Surface setting will print a model as a single-layer outline of the model perimeter. Note that 

this setting will not work with models having a base, solid top, or requiring any inner fill structure.  

  

The part is 50% filled.  

This Fill setting is recommended for 

functional engineering parts. 

The part is 25% filled.  

This is the default Fill setting. 

The part is 17% filled. The part is 12% filled, using the least amount 

of material. 

Mac setting: Solid 

Mac setting: Hollow 

Mac setting: Loose 

Mac setting: Big Hole 
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Support Settings 
Dense  

This sets how many layers of dense support material are printed 

directly beneath the model. More layers of dense support makes for a 

more stable print but takes longer to print. 

Angle  

The Support Angle setting specifies the maximum Angle at which support material will be printed. 

If the angle from horizontal is smaller than the selected setting, the printer will add solid support 

layers under the part surface.  

If the setting is 10 Deg, only surfaces that are less than 10 degrees from horizontal will be given 

support. Changing the value to 50 Deg will print support material to hold up surfaces that are less 

than 50 degrees from horizontal.  

 

 

 

 

 

Increasing this value adds more material and time to the print. 

Decreasing this value may result in poor printing of overhanging 

surfaces. 

There is a balance between minimizing the amount of support 

material and maintaining the quality of the part, as well as minimizing 

the difficulty of removing support material.  

 

 

The orientation of the part on the print platform also determines how 

much support material is printed and how difficult the support 

material will be to remove. 

As a general rule, it is easier to remove support material from the 

outside of a part than from the inside. In the picture to the right, the 

part would use a lot more support material if printed with the opening 

facing down than if it were facing up. 

 

Space 

Space sets the distance between the lines of support material. Changing this value will change 

how the support material is printed; removal of support material and print quality can be affected.  

Only advanced users should change the Space setting. 

  

Angle set to > 10º 

Angle set to > 50º 
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Area  

This setting specifies the surface area above which support 

material is printed. Choose 5 mm
2
 and there will be no support 

if the overhanging area is less than 5mm
2
.  

Lower values in this setting can save time and filament, but 

the stability of the part during printing can be reduced.  

 

Two special options for the Support Area setting are also available. The Only Base setting will use 

a minimum of support material. In many cases, no support material other than that needed to 

support the base of the model will be used. The 0 mm
2
 setting will create support material when 

the Angle setting is met no matter how small the surface area. 

Printer Name (PC Only) 

Enter in a name for your printer.  This makes it easier to identify when you have more than one 

Afinia 3D Printer connected to your PC. 

 

Other Settings 
Stable Support  

Stable support creates support that is more solid so the model is less likely to distort. This can be 

useful where tall, narrow support is needed 

TIP: Setup and configuration settings except for the Nozzle Height Calibration and Platform 

Leveling are stored in the software, not on the Afinia H800 3D Printer. If you move the printer to 

another computer, repeat the calibration and setup procedures. 
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Printing 

TIP: Two keys to successful printing on the Afinia H800 3D Printer are platform preparation and 

preheating.  

The best results will be achieved if: 

• The platform has been leveled and calibrated 

• The nozzle height is correctly set  

• The printer is in a room that is warmer than 65° F and free of drafts 

• The platform is very well preheated  

 

Click Table Preheat 15 mins in the 3D Print menu or Short Press the Filament Button on the 

panel. Click Table Heat 1 hr in the Maintenance window to preheat the platform for one hour.  

When printing with ABS, let the platform heat to at least 90° C before sending the print. 

Maintenance in the 3D Print menu displays the platform and nozzle temperatures. 

Click Print in the 3D Print menu.  

  

 

 

 

 

 

 

 

 

 

 

The software sends instructions for printing each layer of the model to the 

printer. When that is complete, the material usage and estimated print time is 

displayed.  

The USB connection to the printer can be unplugged at this point. 

Print Options 
Nozzle Height 

You can make changes to the Nozzle Height using this setting for the current print only, but it is not 

recommended unless you know that the value you are entering is correct.  

It is recommended that you use the Calibrate Nozzle Height process as listed on page 17 to 

make any changes rather than in the Print dialog. 

Quality 

Options are Normal, Fast, Fine, and Turbo, which affects the speed at which the printer moves. 

Generally, the slower you print the better the quality of the parts. 

For tall narrow parts, running at Fast or Turbo speed can put down layers too fast; if the last layer 

hasn’t yet hardened, the part may distort.  
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For large surface area parts, the Fine setting will take longer to print and the corners of the raft 

may lift from the platform. 

UnSolid Model 

Not all STL files are going to be perfect. A perfect STL file is a fully enclosed surface, with no gaps 

in the surface skin, and no overlapping surfaces. If your file is not perfect, this option should allow 

you to print it anyway.  

The software will auto-detect models that may require this setting and check this option. You can 

remove the check to de-select this function if needed. 

No Raft   

You can print without a Raft, but it is not recommended. The raft improves adhesion to the 

platform.  

Also, the Platform Calibrate feature (see pages 15-16) is bypassed if the raft is not printed. 

Heat Platform after finish 

Checking this option keeps the platform temperature hot after printing is complete, which may 

make it easier to remove the model from the platform. It also keeps the platform heated so you can 

start your next print more quickly.  

Pause At 

Enter heights in millimeters to pause the printer at those heights during printing.  

Multiple heights can be entered into the setting, separated by commas. Entering 13.5, 20, 27.25 

will automatically pause the printing when it has reached 13.5 millimeters, 20 millimeters, and 

27.25 millimeters. 

This can be useful for changing filament or adding a non-printed part at a specific point during the 

printing of the model.  

You do not need to add the height of the raft to the numbers you enter; the software will do this for 

you. 

Use the printer buttons or the Maintenance window during the pause to perform the Withdraw, 

Extrude, and Resume Print functions.  
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Calculating model costs 

Calculate the cost of the material that will be used for your model using the 

Print Preview option under the 3D Print menu. The application will 

calculate the total weight of material used, including the raft and any 

support material.  

Use that weight to determine the cost to print the model using the following 

formula: 

 

                      

Use the weight of the filament that you purchased, not the current weight of the spool. If you are 

using a 500g spool of Afinia Premium Plus ABS filament, divide the cost of the spool by 500g to 

get the cost per gram of material. 

The Fill and Support settings affect the amount of filament used more than anything else. Say you 

are printing a cube measuring 30mm x 30mm x 30mm with a layer thickness of 0.15mm. The 

amounts of material will be used for each of the four Fill settings would be:  

PC Fill Setting Mac Fill Setting Fill Percentage Weight of Model 

 
 50% 17.7 g 

 
 25% 12.0 g 

 
 17% 9.1 g 

 
 12% 8.2 g 

Note: Shell and Surface fill settings results are not shown. 

The cube printed at the lowest density will be about half the cost of printing it at the highest, but 

this may not apply to all models; each model will have a different ratio of surface to infill. Run a 

Print Preview to calculate the printing costs of any given model.  

TIP: Once the print has started, you can disconnect the USB cable to printer. The print job is 

stored in the printer’s internal memory, so the computer is no longer required. Most actions can be 

done using the button panel on the computer – pause printing, for instance - but you will need to 

reconnect the printer to see the exact layer being printed or the nozzle and platform temperatures. 

Save as Project 
Once your model is on the platform and the print settings the way you want them, you can Save as 

Project option under the 3D Print menu to create a 3D print project. All of the settings within the 

Setup or Preferences will be saved, as well as the Quality and No Raft settings.  

Settings that are not saved in a project include the Nozzle Height, UnSolid Model, Heat platform 

after finish, and Pause at settings. 

The project file will be saved with an extension of UPP. This file can be copied to other locations or 

computers without needing to include the original STL file or files.   

Cost of Spool 

Full Filament Weight (        ) Cost to Print = Weight of Model X  
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Model Removal  
You should never attempt to remove the finished model from the print surface while it is still in the 

printer. Doing so may affect the platform leveling or bend the entire platform assembly so that it is 

no longer perpendicular to the printer head.  

 

Use gloves when removing the print surface and model from the printer, as the print surface and 

model may still be hot.  The gloves will also protect your hands from any tools being used to 

release the model from the print surface. 

 

If you are using the Perf board, press the front corners slightly and pull the board forward to 

release it. 

If you are using any method that clips another surface to the printer platform, simply remove the 

clips holding the surface to the platform and remove the entire print surface. 

 

Removal from FR-4 (Perf) Board 

Gently slide the supplied putty knife under the model and 

slowly wiggle it back and forth to lift the support material 

from the print surface.  

Be sure to clean any remaining material from both 

sides of the FR-4 Board once the printed model and 

raft have been removed. 

 

Removal from Borofloat Glass 

After removing the glass from the printer platform, 

allow the glass to cool completely. As the glass cools, you may hear cracking sounds – 

this is the ABS film releasing from the glass.  

If the model doesn’t release from the surface of the glass, spray a small amount of 

ammonia-based window cleaner onto the surface of the glass near the edge of the model. After a 

few moments, the model should release. 

You might need to reapply the ABS film to the glass after each print. 

TIP: Depending on the platform preparation method you are using, the model may be easier to 

remove from the printer when it is still hot. If you want to heat the platform before removing your 

model, use the Table Heat option from the 3D Print menu. 

 

 

CAUTION: It is strongly recommended that you do not attempt to remove the 

model from the platform while the platform is still attached to the printer. Doing so 

may damage the printer or affect the platform level and nozzle height calibration. 

 

GLOVES: It is recommended that gloves be worn as the platform may still be hot 

and to prevent injury from any tool being used to help remove the model from the 

platform. 
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Removing Support Material 
You will most likely need to remove any supports printed along with your model. 

The support material is the same material as the model material, but printed at a lower density, 

making it easier to remove and identify. 

 

The left picture above shows the teapot with its support material still attached, while the right 

picture shows the teapot with support material removed.  

The support material can be removed using a number of tools, and some can easily be removed 

by hand. Wood carving chisels, long nose pliers, or wire cutters work well to remove support 

material. 

 

   

 

  

GLOVES/SAFETY GLASSES: The support material and the tools are sharp. 

Wear gloves and safety glasses when removing the part from the printer. 

 

ALWAYS WEAR GLOVES AND SAFETY GLASSES WHEN REMOVING THE 

SUPPORT MATERIAL! 
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Maintenance 
Changing the Filament 
Changing the filament can be done either in the software or using the control panel. 

1. Remove the magnetic Spool Cover. 

2. Select Maintenance from the 3D Print menu and click Withdraw.  

-or- 

Double Press the Filament button. 

3. Insert the end of filament into one end of the Filament tube, which is on the upper right 

side of the spool holder.  

4. Feed the filament through the tube until about 4 inches of filament protrudes from the tube. 

5. Put the Filament Spool onto the holder with the end of the filament pointing up from the 

back.  

6. Feed the filament into the extruder head as far as it can go, about 2 inches. 

7. Click Extrude in the Maintenance window 

-or- 

Long Press the Filament button. 

8. If the filament doesn’t start feeding when the printer beeps, gently push in the filament. 

9. Replace the magnetic filament cover. 

 

10. If you are changing filament types, click 

New Spool in the Maintenance window, 

select the filament type and enter the 

weight of the new spool. 

This must be done in the software, not 

from the control panel. 

 

TIP: If you are loading a different color filament than the last spool, run Extrude a few times before 

you start printing. This will help remove any left-over filament of the previous color. 

 

CAUTION: If the nozzle is blocked, remove the nozzle and clean it. 

 

GLOVES: The extruder and platform are hot. Use gloves when working in 

this area of printer.  

  



Afinia H800 3D Printer User’s Manual 

 

35 

Cleaning the Nozzle 
The outside of the nozzle can get covered with a layer of filament during regular use. When the 

printer is printing, this layer may melt on the nozzle and leave discolored spots in the model or 

even clog the nozzle. To avoid this, regularly clean the nozzle. 

Click To Bottom in Maintenance and then click Extrude to heat the extruder and melt the coating 

of filament. Wait until the filament is finished extruding, then remove the extruded filament from the 

nozzle. 

Use a heat-resistant material such as 100 percent cotton cloth or soft paper and a pair of pliers. 

With the material between the pliers and the nozzle, apply gentle pressure and turn the pliers to 

remove the filament material. Do not apply heavy pressure!  

Remember, the nozzle can heat up to 260° C (500° F) – that’s over two and a half times the boiling 

point of water. Do not touch the nozzle or nozzle mount with bare skin! 

If this does not clear up any issues, remove and soak the nozzle in acetone overnight to remove 

excess ABS material from the nozzle. Ultrasonic cleaning baths also work. 

Removing / Changing the Nozzle 
If the nozzle becomes blocked, you will need to remove the nozzle in order to unblock or replace it.  

Lower the platform to the bottom. 

Click the Withdraw button on the Printer or Maintenance 

dialog box to remove the filament from the nozzle.  

Once the Withdraw has completed and before the heater 

has a chance to cool below 200° C, use the nozzle 

wrench provided in the toolkit to remove the nozzle.  

Use the same process to replace the nozzle, being sure 

to heat the extruder to at least 200° C before tightening 

the nozzle back down.  

Do not apply too much torque to the nozzle to avoid 

twisting the heater assembly!  

 

TIP: Heating the nozzle to 200° C will make it easier to remove and replace. 

 

WARNING: Be careful when handling the heated nozzle and nozzle wrench! 
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Cleaning the Extruder Gear 
The gear in the extruder may occasionally need cleaning to keep the filament feeding smoothly. 

 

 

1. Long Press the Initialize button on the Control Panel to put 

the printer in sleep mode. 

 

2. Turn off the power switch on the back of the printer. 

 

3. Lift the Cable Cover from the top of the Print Head. 

  

 

4. Disconnect the Ribbon Cable from the 

Print Head. 

 

 

5. Remove the Print Head from the Print Head mount by pulling to the left. 

 

 

 

6. Disconnect the fan. 

 

7. Slide the Print Head Cover off the Extruder Motor. 

 

 

 

8. Remove the two screws on the Extruder Gear Cover and remove 

Cover. 

 

 

9. Clean any filament debris from the teeth of the Extruder Gear. 

10. Replace the Extruder Gear Cover and screws. 

11. Replace the Print Head Cover. Slide it into place until the Cover 

clicks. 

12. Reconnect the fan. 

13. Replace the Print Head into the Print Head mount, making sure all 

three magnets are secure. 

14. Reconnect the Ribbon Cable. 

15. Replace the Cable Cover. 

16. Turn on power and Long Press the Initialize button.  
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Cleaning the Platform 
Regardless of your method of preparing the platform, a smooth surface will improve your results. 

• If you are using the FR-4 Board as the print surface, you should remove any remaining 

filament material from both sides of the board before printing again.  

• If you are using blue painter’s, kapton, or other type of tape on the platform, replace the 

tape once it becomes uneven. Remove excess adhesive from the platform before 

replacing the tape.  

Lubrication of Extruder Rails 
The extruder rails on the Afinia H800 3D Printer requires lubrication every 4-6 months to keep it 

operating smoothly. Different lubricants are required for the two rail bearing types.  

• The Front-to-Back rails should be lubricated with lithium grease such as Mobil XHP 220. 

• For the Left-to-Right rails, use lubricating oil such as Mobil SHC 630.   

When lubricating the bearings, clean the rails as much as possible before applying new lubricant. 

Slide the extruder several times in the all directions to spread the lubricant evenly. 

If you have any questions about lubricating the rails, please contact Technical Support (see page 

46 for contact information). 

Changing the HEPA Filter 
We recommend changing the HEPA filter after 300 hours of printing 

or 6 months, whichever comes first. 

1. Rotate the filter cover counter-clockwise to remove. 

2. Remove the old filter. 

3. Install the new filter in the guide brackets. 

4. Replace the filter cover and rotate clockwise to lock. 

The HEPA filter should be replaced by a Class 7 or better filter. 

Spare parts 
Some of the plastic parts on the printer can be printed by the Afinia H800 3D Printer itself. If you 

need spare parts for your printer, the files for the printable parts can be found in the C:\Program 

Files\Afinia\Example\Spare Parts\H800 folder on PCs and in the Afinia directory off the root of 

the current User directory on Macs. 

Vertical Calibration 
The Vertical calibration procedure allows you to ensure that the printer 

platform is perfectly horizontal and that the printer prints consistently in 

the X, Y, and Z directions. 

Open the file C:\Program Files\Afinia\Example\Calibrate96.UP3 on 

PCs or in the Users\{user name}\Afinia\Calibrate96.UP3 directory off 

the root of the main drive on Macs.  

After the calibration model is printed, remove the platform without 

removing the parts.   
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Open Calibrate from the 3D Print menu. Measure the 

X1 and X2 length, as shown in the pictures below. 

 

 

IMPORTANT NOTE: Before you enter any new 

calibration values, the bar at the very top of the screen 

should read: XY: 0.00 deg / XZ: 0.00 deg. If not, click the 

Reset button!  

 

 

Measure the calibration print from front left to rear right corners of 

the printed parts on the platform for the X1 measurement, and the 

rear left to front right for the X2 measurement.  

Do not include the raft or support material when taking these 

measurements!   

Enter the X1 and X2 measurements into the labeled boxes. 

 

 

 

Next, carefully remove the Front Center ‘L’ shaped component 

from the platform and check the inside angle. If it is not 90º, 

measure the exact distance in millimeters that the end of the 

long arm of the part needs to move to get the angle to be 90º; 

enter that distance into the Z box.  

If the angle is less than 90º, the value to be put into the Z box 

will be positive. If the angle is more than 90º, the value will be 

negative. For example, if the end of the long arm is 1.3 mm 

above the surface, enter -1.3 in the Z box. 

 

 

Finally, measure the long arm of the Front Center component from 

the inside of the angle to the end, which should be 40mm. Enter 

the exact measured value into the H box of the Calibrate dialog box. 

 

Click OK to record all these values and exit the calibration. 

  

Checking the X1 Measurement 
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Tips & Tricks 
Preheat the platform before printing 

Large parts can sometimes have corners lift from the platform, which causes the part to distort.  

Preheating the platform (see page 29) to at least 90⁰ C when printing with ABS is a step you don’t 

want to miss. Having the platform heated before print starts helps keep the model adhered to the 

platform during printing.  

Monitor the platform temperature in the Maintenance window.  

Level Platform and Correct Nozzle Height 

Two keys to successful printing and removal of the print raft is to make sure the platform is level 

and that the nozzle height is set correctly. Use the Maintenance window to bring the nozzle close 

to the print surface, manually level the platform as much as possible, then run the Platform 

Calibration or Auto Level utilities to calibrate the platform and set the nozzle height (see pages 

15-18).  

Be sure to use the calibration utility to build a flat raft surface right below your model!  

Position the parts as close to the center of the platform as possible 

The center of the platform is where the heating is most regulated, which helps to keep the support 

raft adhered to the platform. Try to avoid printing any object near the edges of the platform. 

Model Orientation Tips 

Generally, follow these three simple tips on model orientation for better print results: 

a) Position the model so the largest flat surface is on the bottom 

b) If your model has any cylindrical parts (either solid or holes), position them so they 

are vertical 

c) Minimize support material by orienting the model with as many concave surfaces 

up as possible 

Remember, these orientation tips may not apply to all models. Each model is unique and has its 

own best orientation for printing.  

Scaling your Model 

Not only can the Afinia 3D software scale your model in all three dimensions, you can use the 

Scale function to change the size in any one of the three dimensions independently. For 

instance, you can make your model taller by setting the scale factor and clicking just the Z Axis 

button without affecting the width or depth (see page 23).  

Minimum Model Cross-Section 

Due to the width of the extruded filament, models with portions that have a horizontal cross-section 

of smaller than 0.8mm to 1.0mm may have missing print areas.  

Merging and Rafts 

Positioning multiple models too closely in the software can result in overlapping rafts, leading to 

print failure. Use Merge in the Edit menu before printing to have the software eliminate that 

problem by creating a single raft instead of several. 

Be sure to save these merged models if you will be regularly printing them as a group! 

Minimal Support Material Use 

The Afinia 3D Software includes a feature that allows you to avoid most support material. When 

specifying the Print Preferences, select Only Base for the Support Area setting (see page 27-28). 

Support material around the bottom of the model will still be generated, but the amount of support 

material will be greatly reduced.  
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Tighten the Platform Screws 

Over time, the screws holding the perf board to the platform may loosen.  Tighten them 

occasionally with the perf board installed, but leave them loose enough to remove the board.  

Shell Setting Tips 

The Shell option for the print Fill setting can be used to create truly hollow prints, saving time and 

filament. However, not all models can be printed with this fill setting. 

Models with relatively small horizontal or near-horizontal surfaces are potential candidates for 

shell printing, as these surfaces require little or no internal support to be successfully printed. 

Remember, each model is different – you may need to experiment with each model to find out if it 

can be used with Shell printing.  

Decrease print time where possible 

The faster you can print parts, the less lifting from the platform you are likely to get. Some ways to 

increase print quality include:  

• If possible, try to avoid printing large parts in solid mode 

• Set the layer resolution to as large a value as possible while still keeping the quality 

needed for the finished part 

• Print the part in Normal, Fast, or Turbo mode 

• If printing multiple parts at once, reduce the number of parts that are being printed   

Changing Filament while printing 

If you need to change the filament during printing, Double Press the Play button on the control 

panel.  

When paused, Double Press the Filament button to remove the current filament. After changing 

filaments, insert the new filament and Long Press the Filament button to load your new filament.  

If you are changing colors, you may need to extrude a few times to remove the last of the previous 

filament color. 

Keep the extruded filament string connected to the nozzle – pull it from the nozzle just before the 

nozzle contacts the print surface after resuming the print by Double Pressing the Play button again; 

this helps keep stray strands from sticking to your model. 

Model Creation: What does “Manifold” mean? 

For any model to print correctly, it should be a manifold object. What this means is, as simply as 

possible, is that each edge must be in contact with two and only two surfaces. Most design 

software will allow you to create non-manifold objects, which can result in print problems.  

The most common way for a model to become non-manifold is when several objects are joined 

together, creating surfaces in the model that are in contact with or crossing through each other.  

Fix in the Edit menu of the Afinia 3D software may repair the non-manifold problem areas, but the 

best solution is to correct problems in your design software. Many software packages can check 

for and repair non-manifold models – consult the documentation for your software.  

Model Creation: What does “Surface Normalization” mean? 

The outer layer of every 3D printed object is actually composed of an outer surface and an inner 

surface. Surface Normalization means these surfaces are pointing the correct way. If you have an 

outer surface buried inside your model, or have an inner surface on the outside of the model, you 

will need to normalize the surfaces. 

The most common reason for non-normalized surfaces is when two surfaces cross each other.  

Fix in the Edit menu of the Afinia 3D software may resolve the surface problems, but the best 

solution is to correct the problem in your design software. Many software packages can check for 

and remove non-normalized surfaces – consult the documentation for your software. 
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Status Indicator 
The table below explains what each Status Indicator state means.  

 

Changing Languages 
The Afinia software interface can use multiple languages. To change the language, open the 

application and enter the correct key sequence from the table below.  

The language will change the next time the application is launched. 

Key Sequence Language 

CTRL+ALT+N PC Default Language 

CTRL+ALT+E English 

CTRL+ALT+F French 

CTRL+ALT+G German 

CTRL+ALT+S Spanish 

CTRL+ALT+J Japanese 

CTRL+ALT+I Indonesian 

CTRL+ALT+R Russian 

CTRL+ALT+C Chinese 

CTRL+ALT+T Traditional Chinese 
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Updating the Printer ROM 
Note: This is a function that should only be performed if necessary. 

1. With the H800 Printer on and initialized, select Update ROM from the Tools menu. 

2. Click OK when asked to confirm that you want to update the ROM. 

3. Click OK to select the ROM update file. 

4. Use the browse to find the updated ROM file. This file will be located in the C:\Program 

Files\Afinia\System folder. The file name will include the ROM version just before 

the .ROM file extension. 

5. Click Open when the correct file is selected. 

6. Verify that you have selected the correct file and click OK. Click OK again to begin the 

update. 

7. When notified that the update is complete, follow the prompts and power cycle the H800. 

8. Long Press the Initialize button on the control panel. 

9. Select About Afinia under the Help menu (PC) of Afinia menu (Mac) and verify that the 

new ROM version has been applied. 

Troubleshooting  
Problem or Error message Solution 

No power 
Verify power cord is securely plugged in. 

Verify the power switch on the back of the printer is on. 

Extruder or platform fails to 

reach operating temperature 

Verify printer has initialized. If not, Long Press the Power 

button on the control panel to initialize the printer. 

Heater is damaged. Contact Technical Support (page 46) 

Material not extruding 

Material is stuck in the extruder; remove the material (see 

page 34) 

The nozzle is clogged and needs to be cleaned or changed 

(see page 35) 

Cannot communicate with 

printer 

Print Drivers are not installed. Run the full installation 

Printer not initialized; use Initialize button on the control 

panel or Initialize function in software 

Make sure the USB cable is connected to the printer and to 

the computer 

Unplug the USB cable, then plug in again 

Reset the printer—power off then power on 

Restart the computer 

Others Contact Technical Support (see page 46) 
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Solution for "Winusb.dll not found" problem (Windows) 
If you encounter a “Winusb.dll not found” error message, please 

follow the steps below: 

Option 1: Uninstall Older Driver and Auto-Install New Driver 

1. Open the Windows control panel, go to the System Properties 

dialog box and select the Hardware tab. 

 

2. Click the Device Manager button to open the following dialog 

box. Find the 3DPrinter@FreeMC in the USB section. 

 

3. Click the right mouse button and select the Uninstall option. 

The confirm dialog box will appear. Click OK. 

4. Install the latest Afinia H800 3D software. 

5. Unplug the USB cable then plug it back in. Windows 

will find a new device. Manually select the driver folder 

(the default location is C:\Program Files\Afinia\Afinia 

3D Printer\ Drivers). 

 

 

 

 

 

 

6. There should now be a new 

driver section in the device 

manager as shown to the 

right. 
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Option 2: Update the driver manually 

1. Install the latest Afinia H800 3D Printer software. 

 

 

 

 

2. Find the 3DPrint@FreeMC 

driver in the Device 

Manager dialog box (it 

should be located in the USB 

section). 

 

3. Right click the entry and 

select Update Driver. 

 

 

 

 

4. Select the Afinia H800 3D 

Driver folder (the default is 

C:\Program 

Files\Afinia\Afinia 3D 

Printer\Drivers). 

 

5. A Free Motion Card entry 

should appear in the Device 

Manager list. 
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Specifications 
Printer Physical Characteristics 

Printing Material ABS or PLA Plastic 

Layer Thickness 0.10 – 0.40 mm 

Nozzle Diameter 0.40mm 

Print Speed 10－100 cm
3
/h 

Print Size 259×207×205mm 

Printer Weight 42 lbs. (19 KG) Net 

60 lbs. (27 KG) Gross 

Printer Size 19.5 × 19.5 × 20.5 in  

495 × 495 × 520 mm 

Power Requirements 100-240 VAC, 50-60 Hz, 220W  

Specifications 

Minimum Processor 
PC: Intel Core 2 Duo or equivalent 

Mac: Intel-based only 

Operating System  

Compatibility 

PC, 32-bit: Win XP, Vista, 7, 8  

PC, 64-bit: Win Vista, 7, 8  

Mac, Intel-based: OS 10.6-10.10  

Minimum RAM 2GB RAM required 

Hard Drive Requirements 500MB available space 

Connectivity USB 2.0 

Model Support Auto-generated Support 

Input Format STL, UP3, UPP 

Environmental specifications 
Ambient temperature 60°F～85°F 

Relative humidity 20%～50% 
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Technical Support 

For technical questions or support issues, contact Afinia Technical Support:  

PH: 952-279-2643 

support@afinia.com 

www.afinia.com 

Please have the Model and Serial Number of your Afinia H800 3D Printer available when 

contacting Technical Support.  

Date of Purchase:  

Place Purchased:  

 

Serial Number:  

(Located on back of Printer)  

  

Acronyms and Jargon 

STL   STereoLithography is the common file format used for sharing and printing 3d files 

Additive Fabrication  The technical term used for the more user-friendly term of 3D printing. 

ABS Acrylonitrile Butadiene Styrene is a lightweight thermoplastic with resistance to high heat 

and is the most common plastic used in 3d printing. A strong and generally easy material 

to print with, but printing large parts can warp. 

PLA PolyLactic Acid is a biodegradable material derived from corn. It warps less than ABS but 

support removal can be harder. PLA is a great material to use in investment casting or lost 

wax casting. 

Raft  The printer lays down a foundation before it starts printing the model. The raft is used to 

anchor the model down onto and into the perfboard, as well as correcting any unevenness 

in the raft.  

Perfboard  A reusable and removal build platform that the model is printed onto. (included) 

Shell The external layers of the printed part, much like an egg shell. 

Infill The internal honeycomb structure that gives the part strength 

Smart Support The Afinia software automatically generates supports / scaffold for any overhangs of the 

model during printing, like building a bridge and having scaffolding to support it. 

MEM Melted Extrusion Melting, the process of melting plastic and 3d printing like a hot glue gun. 

Wind Barrier A small flap at the bottom of the print head that controls the air flow onto or away from the 

nozzle. Air blowing over the nozzle cools the molten plastic quickly and can improve print 

quality, but may cause weaker parts and warping 

Warping When a part lifts away from the platform, caused by a poorly calibrated platform or the 

uneven cooling of the part during printing as the material shrinks back to its normal state. 

All materials expand when heated and shrink when cooled. The larger the part the worse 

the effect. ABS is more prone to warping than PLA. 

Air Printing When the printer is moving and acting as if it is printing, but nothing is being extruded out 

of the nozzle. Check the trouble shooting section for help. 


